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Creating Enhanced Multimedia Presentations Using Microsoft Office PowerPoint 2003
The ability to communicate ideas with clarity and precision is imperative for instructors. For this reason Microsoft® PowerPoint® has become an important classroom tool. You have probably already used PowerPoint to highlight the main points of a class lecture or to present research findings or articles at educational conferences. 

Now, with Microsoft Office PowerPoint 2003, you have new and improved options for communicating your ideas and for delivering presentations. 

In this tutorial, you’ll learn how you can: 

· Express your ideas with greater clarity and creativity. For example, you can create custom animations in PowerPoint to illustrate dynamic processes or simply to focus your audience’s attention on the specific point that you wish to address. 
· Share information and collaborate with colleagues. In addition to the multiple options that you have for sharing a presentation over the Web, you can also use the new Shared Workspace to save your presentation to a Microsoft Windows® SharePoint™ Services Web site. Making the presentation available from a SharePoint site enables you or your students to collaborate with others on a presentation. It streamlines the review process and facilitates clear communication among people on a team. 
· Broaden your reach. You have more choices for delivering content with PowerPoint 2003. Package for CD makes it easy to burn your presentation to a CD so that you can provide an archive of course lectures at the library or share your conference presentation with colleagues. You can choose to include PowerPoint Viewer on the CD so that people without PowerPoint installed on their computers can view your presentations. Additionally, you can use Microsoft Producer for PowerPoint 2003 to create, organize, and publish multimedia presentations that are viewable from a Web browser.
Getting Started
Although not required, you will find it easier to complete this tutorial if you already know how to:

· Navigate the PowerPoint interface, including the standard menus and toolbars.

· Create a slide show using PowerPoint templates.

· Change views in a PowerPoint presentation.

If you do not already know how to complete these tasks, take some time to familiarize yourself with PowerPoint by reviewing “Creating Presentations,” available at Microsoft Office Online. You can find a wealth of information about PowerPoint 2003 and other Microsoft Office 2003 programs at Microsoft Office Online.

To access Microsoft Office Online 

1. Open PowerPoint 2003.

2. On the Help menu, click Microsoft Office Online. 
System Requirements
To complete this tutorial, you must have the following software installed on your computer:
· Microsoft Office 2003

· Microsoft Producer 2003.  To download a copy of this free add-in, go to http://www.microsoft.com/office/powerpoint/producer
Your computer should also be equipped with the following:

· A recordable CD (CD-R) and a Read-Write CD-drive

· A soundcard and microphone

You must also have access to a server running Microsoft Windows 2003 with Windows SharePoint Services. You should also have Contributor or Administrator permissions on a SharePoint site on the server. If you do not have access to this software, skip the section of this tutorial entitled “Collaborating on Presentations.” 
In addition, you should have downloaded the following files to your computer when you downloaded the tutorial: 
· Earthquakes.ppt
· Juan de Fuca.jpg
· St_Helens.jpg
· Intro_Video.wmv
· Video2.wmv
If you want to view a completed multimedia presentation created using Producer, you should also download PNW_Earthquakes.zip to your computer from the Microsoft Education Web site.

Using Graphics and Animation

People typically use PowerPoint simply to summarize the main points of a presentation or lecture. You may find that the slides keep your students focused and help them to recognize key issues in a class discussion. PowerPoint slides can be particularly helpful for students who are not auditory learners. 

At times, however, words are not sufficient to convey your main point. For some topics, a visual representation—an illustration, diagram, or photograph, for example—can more effectively communicate your ideas. 
Assume, for example, that you are teaching a course on the physical sciences, and you are starting a unit on earthquakes. You already have a set of slides that describe earthquakes in the Pacific Northwest, but you want to illustrate tectonic plate activity during an earthquake. You decide to add a few images to illustrate your point.

You can select an image from the many multimedia elements available on Microsoft Office Online, or add one from your own collection. PowerPoint 2003 supports all of the common types of graphic files.   
To add graphics to your presentation

3. Open Earthquakes.ppt, and go to Slide 3, Cascadia Subduction Zone.

4. On the Insert menu, click Picture, and then click From File. 

5. Browse to the file entitled Juan de Fuca, and then click Insert.

6. Click the image in the slide, and then drag it to the left side of the slide, just beneath the heading.

7. On the File menu, click Save to save your work.

Graphics can be helpful for illustrating points, but used inappropriately, they can distract from a presentation. If you plan to have your students do presentations, it may be useful to provide them with these simple guidelines for using images effectively: 
· Be clear about your purpose. Don’t use graphics just to dress up your presentation. Make sure that the image makes sense in the context in which you’re using it. The image should support the point that you are trying to make and be readily understood by your viewers. 

· Consider adding labels. Sometimes you can’t position an image close to or even in the same slide with the text that it supports. To help your readers understand the relationship, add labels or captions to your images. 
· Use adequately sized images. Size requirements may vary depending on whether you will be giving the presentation in a large and crowded auditorium or showing it over the Web. Consider what size is required to make the image easy to see and to read by viewers.

· Don’t include too many images. Just as you include concise representations of your main speaking points in a PowerPoint presentation, you should also include images sparingly so as not to detract from the overall organization and effectiveness of your presentation. 
· Add alternative text for graphics. If you plan to publish a slide show as a Web page, add alternative text for the graphics. This helps users who rely on screen review utilities to interpret information based on the text. Alternative text also compensates for graphics that do not load because they are missing. 
Adding Custom Animation

In addition to adding graphics, you may want to add some animation to your PowerPoint slides. Animation can help you control the flow of information, focus your audience’s attention on important points, and even illustrate relationships or concepts.

Using PowerPoint 2003, you can animate text, graphics, diagrams, and charts in your slides. You can apply a preset animation scheme to items on all or select slides, or for more control you can use the Custom Animation task pane.  

The Custom Animation task pane enables you to control how and when an item appears on a slide during your presentation. For example, you can create animation so that each of your main points flies in from the bottom of the slide when you click the mouse. This prevents your audience from reading forward to your second and third points while you are still discussing your first point. 

The following illustration shows the Custom Animation task pane. 
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Figure 1: Custom Animation Pane

In your Earthquake slide show, you decide to add animation to control how and when the text appears on your slides.  

To add custom animation to your presentation

8. On the View menu, click Normal.

9.  Go to Slide 4, Mount St. Helens, and then click Eruption May 18, 1980. 

10. On the Slide Show menu, click Custom Animation. 

11. In the Custom Animation task pane, click the Add Effect arrow, click Entrance, and then click Fly In.
12. In the Start box, click On Click.

13. In the Direction box, click the direction from which you would like the text to fly  on to the screen.

14. In the Speed box, click the speed at which you would like the text to fly in.
15. Select the next element on the slide that you would like to animate, and repeat steps 4–7. Continue until you have added animation for all the text on the slide.

Note:  Animations appear on the slide in the order in which they are customized. Be sure to add animation to the text in the sequence you want it to appear.
16. To preview the animations that you have added, click Slide Show in the Custom Animation task pane. Do not forget to click the mouse to prompt each set of animations to appear.

Adding Narration to a Presentation

When you give a presentation, how you say something can be as important as what you say. Each time that you deliver a class lecture, for example, you may find yourself modifying the talk in relation to your students’ questions and reactions. In most cases, this dynamic interplay between speaker and audience is beneficial; in some situations, however, it may not be possible or advisable. 

To ensure that the slide show you create is most effective in communicating your ideas, you can use PowerPoint 2003 to record narration. 

Adding narration to a slide show is especially helpful in the following situations:

· When you want to deliver course materials online. You can record class lectures, including the question-and-answer period, so that students taking an online course or students who simply miss class can enjoy the complete classroom experience.
· When you want to create a self-running slide show presentation. This is useful when you have a scripted set of information that you want to provide to your audience, and your plan is to engage them in discussion after the slide show. 
· When you want to include other voices in your presentation. You can record on selected slides a speech by or an interview with a person who can’t be present for the presentation. 
All you need to record narration for your slide show is a sound card, microphone, and speakers. (Most computers now come with sound cards and microphones.) As you record the narration, PowerPoint records on each slide the amount of time that you take. You can choose to save these slide timings with the narration, or you can set slide timings separately. You can pause and resume recording at any time.
To record narration

17. In Earthquakes.ppt, select Slide 1. 

18. On the Slide Show menu, click Record Narration. 

19. Click Set Microphone Level, follow the directions to set your microphone level, and then click OK. 

20. When the first slide appears, begin recording the narration. Speak normally and as clearly as possible. When you have completed the narration for the first slide, press ENTER to advance to the next slide. 

Note:   If at any time you want to pause and then resume the narration, right-click the slide, and on the shortcut menu, click Pause Narration. To resume, click Resume Narration.

21. Repeat Step 4 until you have completed the narration for each slide, and then click the Black Exit screen. 

22. Click Save to save the slide timings and review the slide timings.

23. Return to the first slide by clicking it in the slide sorter view, and then, to play your presentation, select View Show, or click the Slide Show from Current Slide button at the lower left corner of the presentation window.

24. If you do not like your narration and want to rerecord it, on the Edit menu, click Undo Record Narration and record the narration again. 
Note:   If you record the narration without clicking Undo Record Narration, you will record a second narration on top of the original recording.
25. When you are satisfied with the recording, click Save from the File menu to save your presentation and narration.

Collaborating on a Presentation

Working together on projects can be incredibly beneficial for students. Often they discover new ways of thinking about issues from group work, and, ideally, they learn something about how to work effectively as a member of a team. Likewise, you may have discovered that team teaching with a colleague or co-authoring an educational article has enhanced your teaching philosophy or given you new techniques to try in the classroom. 
To facilitate the process of collaborating on presentations, you and your students can now use a Shared Workspace in PowerPoint 2003 to simplify the process of co-authoring or reviewing slides with others. 

Note:   You must also have access to a server running Windows 2003 with Windows SharePoint Services, and you must have Contributor or Administrator permissions on a SharePoint site on the server to complete this section of 
the tutorial.
From the Shared Workspace task pane, you can create a Document Workspace within a Windows SharePoint Services Web site where you can store all the files and information related to a project, including contact information, project milestone dates, and links to important Web sites. You can add information to the Web site and access information stored there from within the Shared Workspace task pane.

If you already have a SharePoint site set up within your institution or department, and you have administrative access to that site, you can create a Document Workspace: 

· From within the existing SharePoint site by using your Web browser.

· From the Shared Workspace task pane of your PowerPoint file.
· By sending the file as a Shared Attachment from Microsoft Office Outlook® 2003. When you send the file as a Shared Attachment, PowerPoint automatically creates a Document Workspace as a subsite of the Windows SharePoint Services site that you specify. All recipients of your e-mail message get a local copy of the slides that they can edit offline. When they are connected to the Internet, they can go directly to the SharePoint site to see edits from the rest of the team. 
You decide to create a Document Workspace from the Shared Workspace task pane. 

To create a Document Workspace
26. In Earthquakes.ppt., on the Tools menu, click Shared Workspace.
27. In the Document Workspace name box, type a name for the Workspace.

28. In the Location for new workspace box, type the URL of the existing SharePoint site where you want to create the Document Workspace. 

29. Click Create. 

Now that you have created the Document Workspace, you can use the Shared Workspace task pane to add members to the workspace, to specify tasks that need to be completed on the project, and to add related files for the project. Take some time to explore the different tabs of the Shared Workspace and what you can do from each one.

If you are interested in learning more about Windows SharePoint Services and how it is integrated with all Microsoft Office 2003 products to facilitate collaboration between colleagues and between students, see “Enabling Teamwork and Collaboration with the New Microsoft Office System” at www.microsoft.com/education/?ID=OfficeSystemTutorial
Sharing Your Presentation

PowerPoint 2003 gives you more options for delivering your presentation and enables you to accommodate the needs of a wider variety of audiences. 
With PowerPoint 2003, you can deliver your presentation by using the following features: 

· Save as Web Page. Convert your entire presentation or select slides into HTML-based pages, which look like your original slides, complete with narration. You can customize the Web presentation to ensure that it appears correctly in different browsers. 

· Package for CD. You can burn your presentation, including all associated graphics and audio and video files, to a CD-ROM. Recipients of the CD-ROM can view your presentation exactly as you created it, even if they have an earlier version of PowerPoint or do not have PowerPoint software on their computers at all.  When the recipient inserts the CD into the CD drive, the presentation automatically launches in slide show mode using PowerPoint Viewer. 

In addition, you can save your slide show in a particular format—for example, in slide show or outline format—and you can save it for compatibility with an earlier version of PowerPoint. These options give you more control over how the presentation appears when you make the file available to others.

Before you make a decision about how you want to distribute your presentation, it is helpful to understand how each of the options for distributing your presentation affects your audience’s experience. The following table describes some of the more common format options. For a complete description of the formats available, see PowerPoint Help.
	When you…
	You can…
	Description

	Save your presentation as a Single File Web Page…
	Publish it to the Web or send it to people as an attachment to an e-mail message.
	This option saves all the elements of the Web page, including all supporting texts and graphics, into a single file, which makes the presentation easier to store and publish. This format is supported by Microsoft Internet Explorer 4.0 and later.

	Save your presentation as a Web page…
	Publish it to the Web.
	This option enables people to view your presentation in a Web browser, but they may not see all the effects included in your presentation, such as custom animation. The effects they will see depend on the Browser that they are using and the Publish options that you select when you save the file.

	Package a presentation for CD…
	Distribute one or more presentations on a CD.
	The PowerPoint Viewer is included by default on the CD and will run the packaged presentations on another computer even if PowerPoint is not installed.  You must have Microsoft Windows XP or later to Package for CD.


 Let’s say that you are creating an online version of a course that you teach. You can save your presentation as a Web page and optimize it for viewing in a particular Web browser.

To save your presentation as a Web page

30.  Open Earthquakes.ppt, and on the File menu, click Save as Web Page.

31. Browse to the folder where you would like to save your Web page, and then, in the File name box, type a name for the Web page. 

32. In the Save as type box, do one of the following: 

· To save as a Web page and create an associated folder that contains supporting files, such as bullets, background textures, and graphics, click Web Page. 

· To save as a Web page that integrates all supporting information, including graphics and other files, into a single file, click Single File Web Page. 

33. Click Publish, and then, if you want to publish all of your slides, in the Publish as Web Page dialog box, click Complete presentation.
— or —
If you want to publish only select slides, in the Publish as Web Page dialog box, click Slide number, and type or enter the slides that you want to publish.  
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34. If you want your audience to view your notes on the slides, select the Display speaker notes check box. Notes can be useful for audience members who are not able to hear the narration. 

35. Under Browser support, click the Web browser versions that you would like to support.

36.  If you would like to preview your presentation in a Web page immediately, select the Open published Web page in browser check box, and then click Publish.

You also decide that you want to burn your presentation, along with all of your other presentations for this class, to a CD-ROM so that you have a backup copy for your records. To do this, you need a blank recordable CD (CD-R), a blank rewritable CD (CD-RW), or a CD-RW with existing content that can be overwritten. If you use a CD-R, make sure that you copy all the files that you need onto the CD the first time. After the files are copied, you can't add more files to the CD.
To package for CD-ROM

37. Insert a CD-R or CD-RW into your computer’s CD drive. 

38. Open Earthquakes.ppt., and on the File menu, click Package for CD. 

39. In the Name the CD box, type a name for the CD. 

40. If you would like to add other files to the CD, click Add Files, select the files you want to add, and then click Add. Your presentations are set up to run automatically in the order in which they are listed in the Files to be copied list. 

Note:   By default, the presentation that is currently open is already in the Files to be copied list. 

41. Click Copy to CD. 

 Using Producer for Multimedia Presentations

In some situations, a PowerPoint slide show may not satisfy all of your presentation requirements. For example, you may find that a video clip helps to communicate a historical event that you are describing in your presentation, or you may want to integrate still images with an audio file. 

You can use Producer, a free add-on to PowerPoint 2003, to create multimedia presentations that include PowerPoint slides, Microsoft Windows Media® video or audio files, and still images. You can also synchronize a narrative audio file with the multimedia presentation that you put together. 

You can distribute your Producer presentation just as you would a PowerPoint slide show, by burning it to a CD, for example, or publishing it to a Web site. 

Before you start creating a presentation by using Producer, take some time to familiarize yourself with these important concepts:

· Project. When you work in Producer, you create a project. A project links all the files that you have imported or captured in Producer, including PowerPoint slides, audio and video files, and images.  A project file only links the content on your computer; it does not contain the actual files. Therefore, if you create a project and then move the source files, the project will no longer be able to find the files.
· Presentation. A presentation contains all the slides, video, audio, HTML files, and other digital media files that you have added to the timeline in your Producer project. It is different from a project, however, in that it contains all the files required for the presentation and not just links to them. You can publish a presentation to an intranet site or a Web site, or you can save it to a rewritable CD. However you save a presentation, it must be opened and viewed in a Web browser. 
· Templates. Templates in Producer are basic cascading style sheets (.css files) that determine how the individual elements in your presentation are displayed. For example, the template may determine the background color that appears in your presentation. By adding a template to your presentation, you can change the layout of all or part of your presentation to emphasize the video or other multimedia elements. 
The following illustration shows the Producer interface.
[image: image3.png]© Untitled - Microsoft Producer
Ee Edt dp Py

DEH *B@X o

Vew Tooks

= (] Sides
 fervauses ]

Crm

[ iceo Transitons
L vceoetects

e

052000 0EN000

& RR| > prmwEEw

TAIA000 " G132000 " G000

Transiton

Audo

Side

Audo2





Figure 2: Producer Media tab Interface
The main window is divided into three panes:

· Menu bar and toolbar. These include some of the familiar elements of all Office products, and additional icons and menus, such as Clip and Play, that provide task options specific to Producer.
· Tabs. Producer has three main tabs.  The Media tab displays all the files that you have to work with in your current project.  It includes a Tree pane, a Contents pane, and a Monitor. The Table of Contents tab enables you to create and edit a Table of Contents for your presentation. The Preview Presentation tab enables you to preview your presentation as it will appear when you publish it. 

· Timeline. You use the timeline to arrange and edit files in your project. The timeline includes a discrete area for each type of media that you want to include in your project. After you have imported a file into your project, you can drag and drop it into the timeline from the Contents pane. After you place a file on the timeline, you can then drag that file to another place on the timeline. When you drag a file to move it on the timeline, a vertical line indicates when that specific file will begin to play. 
Creating a Project

You have two options for creating a new project in Producer. You can create a project from scratch or you can use the New Presentation Wizard. The New Presentation Wizard walks you through the tasks of creating a presentation, including choosing a template for your presentation and importing the source files that your presentation will use. The New Presentation Wizard is a good option if you are not familiar with the Producer interface; however, you have more control when you create a new project from scratch. 

It is advisable to use the New Presentation Wizard to create your first multimedia presentation. Later, you can edit the project manually to ensure that your presentation is exactly how you want it to be.

To create a project using the New Presentation Wizard

42. On the Start menu, click Microsoft Producer for PowerPoint 2003. 

43. In the Microsoft Producer dialog box, click Use the New Presentation Wizard, and then click OK. 

44. On the Welcome to the New Presentation Wizard page, click Next to continue in the wizard. 

45. In the Templates area, click the Default template, and then click Next. 

46. On the Choose a Presentation Scheme page, do the following to specify color scheme and font attributes for your presentation: 

· In the Font list, click the font for the table of contents text. 

· In the Font size list, click a size for the table of contents text. 

· In the Font color box, click the color for the table of contents text and table of contents entries. 

· In the Background box, click the background color for the table of contents area in your presentation. 

· In the Slides area background box, click the background color for the area in which your slides are shown in your presentation. 

47. Click Next.

48. In the Title box, type Earthquakes in the Pacific Northwest. The title will appear on the introduction page of your published presentation. 

49. In the Presenter (optional) box, type your name. This name will also appear on the introduction page. 

50. In the Introduction page image (optional) box, click Browse, and then browse to the location on your computer where you stored the St_Helens.jpg file.  Click the file, and then click Open. 

51. In the Description (optional) box, type a short description of the contents of your presentation, and then click Next. 
52. To specify the PowerPoint presentation that you want to import into the current project, click Browse, and then browse to the Earthquakes.ppt file. Click the file, and then click Open to select the file. The selected file or files are automatically added to the Files area. Click Next. 
53. To import a video into your current project, click Browse, and then browse to the Intro_Video.wmv file. Click the file, and then click Open to select the file or files. The selected file is automatically added to the Files area. Repeat this step to import Video2.wmv, and then click Next.
54. When you import any combination of slides and still images with video and audio, the Synchronize Presentation page appears. 
· If you want to begin synchronizing your slides or images to the video or audio that you selected after the files are imported and the New Presentation Wizard has finished, click Yes. 

· If you do not want to begin synchronizing your slides or images to the selected audio or video after the files are imported and the New Presentation Wizard has finished, click No.
Click No.
55. To complete the New Presentation Wizard and to import the files that you selected, click Finish. 

Using the Capture Wizard

Using the Capture Wizard, you can record audio, video, and still images from a variety of sources to your computer. For example, you can capture audio and video recorded on tape or live in Producer, and you can capture the image or video that is currently displayed on your computer screen. 
The first page of the Capture Wizard describes the different capture options available to you. Whenever you want to learn more about any of the options available from the Capture Wizard, just select the option, and the Capture Wizard provides a brief description of that option in the bottom pane of the Wizard.
When you use the Capture Wizard, any captured content is automatically imported into your current project when you save the captured file. 

For your presentation, you decide to narrate some of the slides by capturing an audio file using the Capture Wizard.

To capture an audio file using the Capture Wizard
56. On the Tools menu, click Capture. 
57. To automatically synchronize the audio with the PowerPoint slides that you have already imported into your project, click Narrate slides with audio, and then click Next.
58. Click the capture settings that you want. The Capture Wizard provides guidelines for selecting the appropriate settings, and then click Next.
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59. Click the capture devices that you will use to create your audio file, and then click Next. 
Note:   If your computer has only one audio capture device, that device is automatically listed in the Audio device box. 
60. Follow the step-by-step directions provided by the Capture Wizard to record and synchronize audio with your presentation slides. 
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61. When you have completed the audio recording, click Finish. Producer will import the audio content into your project timeline. 
Editing your Presentation

You’ve added all the files that you want in your project; you’ve created an audio file to accompany the presentation; and you’ve edited the Table of Contents. You can now preview your work from the Preview Presentation tab. If you decide that you are not satisfied with some aspects of the presentation, you can easily edit the project, including the Table of Contents. 

Producer automatically creates a Table of Contents for you when you create a project using the New Presentation Wizard. When you add slides or still images to the timeline in your project, the title of each slide or the file name for the image is added to the Table of Contents. You can change the information displayed in the Table of Contents or add additional items to the Table of Contents if you want. 

You may also choose to add entries to the Table of Contents to mark other points in your presentation. This gives your audience more flexibility in navigating your presentation. They can click the link in the Table of Contents to play or replay that part of the presentation. 

To add an entry to the Table of Contents

62. From your open project, click the Table of Contents tab.

63. Click the entry above where you want to add an entry, and then click Add.

64. In the Name box, type the text that you want to appear in the Table of Contents entry.

65. Click the Associate with arrow, and then click the object to which you want to attach the new entry. If you attach the entry to the timeline, the entry refers to that specific point of time in your presentation. If you then later move the object on the timeline, the entry will move with the object.

66. Click OK to add the new entry to the Table of Contents.

After you edit the Table of Contents, you decide to change the template.

To change the Template

67. From your open project, click the Media tab.

68. In the Tree pane, click the Presentation Templates folder.

69. To remove the existing template, in the timeline, right-click the Template bar, and then click Delete.

70. To add a new template, click the template that you want from the Contents pane, and then drag and drop it into the Template bar of the timeline.

For your last edit, you decide to add some transitions between sections of your presentation.

To add transitions

71. From your open project, click the Media tab.

72. In the Tree pane, click Video Transitions.

73. Select the transition that you want from the Contents pane, and then drag and drop it into the Transition bar of the timeline. You should position the transition between the video frames where you want it to appear.

Saving and Publishing Your Presentation

When you are satisfied with your final presentation, you can save your project to your local computer, or, if you know that you will want to access the project on a different computer at another time, you can use the Pack and Go Wizard. The Pack and Go Wizard saves and compresses all the associated source files, including slides, audio and video files, and still images, to a single archive. This enables you to open a single project file on another computer with all the project effects, including links and transitions, intact.

When your project archive is unpacked, the source files are unpacked and organized according to file type. For example, if your project contains video files, they are saved in the Video folder. Likewise, folders are created to store files for Audio, Images, HTML, Slides, and Presentation Templates. 
To create a project archive

74. On the File menu, click Pack and Go. 

75. On the Welcome to the Pack and Go Wizard page, click Next. 

76. In the File name box, type a file name for your project archive. Then, in the Location box, click the location where you want your project archive to be saved or click Browse to browse to and click a location. Click Next.
Note: When you name the project archive, the .msproducerz file name extension is automatically added to the file name to indicate that it is a compressed Producer file.

77. On the Project Archive Setting page, do one of the following: 
· To save a project archive as one file, click One file. 

· To save a project archive that you plan to store or later copy to another location, such as a recordable or rewritable CD or a compressed disk, click Multiple files for storage on, and then click the media with the appropriate file size. Each file in the project archive will be saved with the specified file size. 

· To specify the file size for each file in the project archive, click Multiple files, each, and then type a custom file size. 
Click Next.

78. After the project archive is created and saved, click Done. 
If you plan to distribute your Producer presentation for others to view, you can use the Publish Wizard. The Publish Wizard offers three options for delivering your presentation:
· Publish your presentation on your computer or to a CD. The advantage of this option is that your presentation can be streamed directly from a Windows Media server. This option does limit the distribution of your presentation, however, to those who have local access to your computer or a copy of the CD. 
· Publish your presentation to a shared network location. This is a great option when you want to distribute a presentation to students or colleagues and your educational institution grants students permission to access the entire network or some directories on the network.
· Publish to a Web server. Files are stored on a Web server so that your audience can access them from a Web browser. While more people can view a presentation that is available over the Web, this option also means that your audience will have to wait for a portion of the presentation to be downloaded to their computer before they can watch it. They must also have Microsoft Windows Media Player on their computer.
For more information about publishing Producer files, see “Understanding capture and publish settings” in Producer Help.
You have now learned how to create a multimedia presentation using Microsoft Producer. If you would like to view a finished presentation, complete the following procedure.

To View a Presentation

79. If you have not done so already, go to www.microsoft.com/education/?ID=PPT2003Tutorial and download PNW_Earthquakes.zip. 

80. Unzip the files contained in PNW_Earthquakes, and save them to a location on your hard drive. 
81. Browse to the location where you have saved the PNW_Earthquakes files, and click PNW_Earthquakes_HED_demo. 

Using Information Rights Management

Much of this tutorial has focused on how you can use the publication options available in PowerPoint and Publisher to share your presentation with a larger audience. It’s equally important, however, to preserve the integrity of your work. You do not want your intellectual property to be viewed by an audience for whom it was not intended, nor do you want people to modify a presentation that you have carefully crafted to communicate your ideas.

Now, with Information Rights Management (IRM), you can authorize how your electronic documents, including PowerPoint presentations, get used. You can restrict whether a document or e-mail message can be copied, forwarded, or printed. You can also set an expiration date; when the file reaches its expiration date, it will no longer be available for others to view. 
When you create a PowerPoint presentation, Microsoft Word document, or Microsoft Excel workbook, you can set permissions to determine what people can do with the document:

· Read. Users with Read access can read the contents of a file, but they cannot edit, print, or copy the file.
· Change. Users with Change access can read, edit, and save changes to the file, but they cannot print the file.
· Full Control. Users with Full Control access have full authoring permissions and can do anything with the file that the author can do.
When users receive a file with restricted permissions set on it, they can open and view the file contents just as they would a regular file. 

Note:   You can create content with restricted permissions using Information Rights Management only in Microsoft Office Professional Edition 2003, Microsoft Office Word 2003, Microsoft Office Excel 2003, and Microsoft Office PowerPoint 2003.
To set permissions

82. On the File menu of the document that you want to protect, click Permissions, and then click Do Not Distribute.

83. In the Permission dialog box, select the Restrict permission to this <file type> check box.

84. In the Read and Change boxes, type the names or e-mail addresses of the people to whom you want to give permission.
85. Click OK, save your file, and distribute it.

Taking It Further

This tutorial has briefly described some of the features of PowerPoint 2003 and Producer 2003 and how these tools can help you to express your ideas and help your students to express themselves. Following are some additional resources that you may find helpful for using technology effectively in the classroom. 
For more information about how to use the new Microsoft Office System, visit http://www.microsoft.com/office/preview/editions/online.asp
For more ideas about how to use Microsoft technologies in the classroom, visit http://www.microsoft.com/education
For more information about how to use Microsoft Producer, visit  http://www.microsoft.com/education/?ID=EdGuideProducer
Information in this document, including URL and other Internet Web site references, is subject to change without notice. The names of actual companies and products mentioned herein may be trademarks of their respective owners. Names and data used in examples herein are fictitious unless otherwise noted.
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What you will do:


Enhance a simple presentation with graphics and animation


Record narration for a stand-alone slide show


Save your presentation as a Web document


Set up a Document Workspace for collaborating with colleagues on a presentation


Create a Producer file using PowerPoint slides, video, and audio files
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�


You can use the new Research and Reference feature in Microsoft Office 2003 to locate information or graphics available on the Web from within your PowerPoint file. You can customize the sources used for searching, and drag and drop information straight from the Web page to your file. The source citation will be automatically added to the information in your file.





�


Because audience needs and equipment varies, consider adding notes to the slides that relay the narrative thread.  Notes will assist anybody with a hearing disability and those whose computer lacks a sound card.





�


The recording quality you select can affect the size of your file. Higher recording quality uses more disk space. One option for decreasing the size of the file is to link the narration to the slideshow instead of embedding it. A linked file will also play faster. 








�


The Shared Workspace is available from each of the core Microsoft Office applications, including Microsoft Word and Microsoft Excel.








�


The Capture Wizard can be started from within the New Presentation Wizard by clicking Capture from the Import or Capture Audio and Video page of the Wizard. This enables you to import existing video and audio files into a new project and to capture new content—all while you create your new presentation. 





�


When you save a project, Producer creates an IMS/SCORM manifest automatically. You can then upload the manifest into a Learning Management System (LRN). For more information, see “Building Interactive Courses Using LRN 3.0” at � HYPERLINK "http://www.microsoft.com/education/default.asp?id=lrn2tutorial" ��http://www.microsoft.com/education/default.asp?id=lrn2tutorial�
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